# Table of Contents

**About This Manual** .............................................................................................................. iv

- Document Organization .......................................................................................................... iv
- Document Conventions .............................................................................................................. iv
- Where to Send Comments ......................................................................................................... iv

**Chapter 1 – About the OPC/SNMP Agent** .................................................................... 5

- What is SNMP? .................................................................................................................. 5
- What is the OPC/SNMP Agent? ........................................................................................... 5
- System Components ............................................................................................................... 6
  - Insight OPCServer .............................................................................................................. 6
  - OPC/SNMP Agent .............................................................................................................. 6
  - SNMP Manager and MIB ................................................................................................. 7
- System Requirements ............................................................................................................ 7

**Chapter 2 – Installing and Configuring the OPC/SNMP Agent** ..................................... 9

- Before You Install the OPC/SNMP Agent ........................................................................... 9
- Getting IP Addresses ............................................................................................................. 9
- Setting Up SNMP Services .................................................................................................. 10
- Installing the OPC/SNMP Agent ......................................................................................... 11
- Requesting a License ............................................................................................................ 11
- Setting Up the SNMP Database ........................................................................................... 12
- Setting up the OPC Engineering Tool .................................................................................. 12
  - Verifying Communication with the Insight OPCServer Database ................................ 12
  - Configuring the OPC Engineering Tool ......................................................................... 13
  - Accessing and Viewing OPC Items ................................................................................ 14
- Setting Up the SNMP Engineering Tool ............................................................................. 15
  - Entering General Settings for the SNMP Engineering Tool ........................................ 15
  - Adding MIB References ................................................................................................ 16
About This Manual

The *OPC/SNMP Agent Manual* provides information for installing and configuring the OPC/SNMP Agent—the OPC/SNMP Solution for Insight®.

Document Organization

The *OPC/SNMP Agent Manual* consists of the following chapters:

*Chapter 1 – About the OPC/SNMP Agent*
Provides descriptions of SNMP, the OPC/SNMP Agent, system components, and system requirements.

*Chapter 2 – Installing and Configuring the OPC/SNMP Agent*
Provides procedures for installing and configuring the Insight workstation for the OPC/SNMP Agent.

Document Conventions

The following table lists conventions designed to help you use the *OPC/SNMP Agent Manual*.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names of menus, menu commands, buttons, dialog box tabs, and fields are in boldface type.</td>
<td>Details on the View menu OK (button) Services tab Active check box</td>
</tr>
<tr>
<td>Numbered and lettered lists indicate a procedure with sequential steps.</td>
<td>1. On the File menu, click New. 2. In the Group box, type a name for the group. 3. Click OK.</td>
</tr>
<tr>
<td>Actions that you should perform are specified in boldface type.</td>
<td>1. Type F for Field panels. 2. Click OK to save the information and close the dialog box.</td>
</tr>
<tr>
<td>Angle brackets [placeholder] indicate text that can vary.</td>
<td>Type cd[folder name].</td>
</tr>
<tr>
<td>Error and system messages are displayed in Courier New font.</td>
<td>The message Report Definition successfully renamed is displayed in the status bar.</td>
</tr>
</tbody>
</table>

Where to Send Comments

Your feedback is important to us. If you have comments about this manual, submit them to technical.editor@siemens.com.
Chapter 1 – About the OPC/SNMP Agent

Chapter 1 contains the following topics:

- What is SNMP?
- What is the OPC/SNMP Agent?
- System Components
- System Requirements

What is SNMP?

Simple Network Management Protocol (SNMP) is a standard protocol that enables information exchange between devices on a TCP/IP network.

What is the OPC/SNMP Agent?

The OPC/SNMP Agent receives Insight OPCServer information and makes it available via SNMP. The OPC/SNMP Agent works with the standard SNMP services provided by Microsoft® Windows® 2000.

Key features of the OPC/SNMP Agent are the following:

- Enables Insight point monitoring and commanding via SNMP
- Provides configurable options for accessing point information, such as name and security
- Enables alarm monitoring, acknowledgement, and clearing via SNMP
- Compatible with SNMPv1 and SNMPv2
- Supports COM and DCOM
System Components

Accessing Insight point information via SNMP requires Insight with the OPCServer Option, the OPC/SNMP Agent, an SNMP manager, and a Management Information Base (MIB). Figure 1 shows the connections between each system component.

![Figure 1. System Components.](image)

**Insight OPCServer**

Using Insight with the OPCServer Option, you define the Insight points that you want to access via SNMP.

**OPC/SNMP Agent**

The OPC/SNMP Agent consists of the OPC Engineering Tool and the SNMP Engineering Tool. These tools help to translate the OPCServer information into data that can be accessed via SNMP.

**OPC Engineering Tool**

Using the OPC Engineering Tool, you select the point information that you want to extract from the OPCServer database.

**SNMP Engineering Tool**

Using the SNMP Engineering Tool, you define the point information that you want to make available to an SNMP manager.
SNMP Manager and MIB

To access Insight point information via SNMP, a computer must have an SNMP manager and a Management Information Base (MIB) file. The SNMP manager uses an MIB to interpret the information received from the OPC/SNMP Agent.

An MIB file contains group, variable, and trap information that correlates to Insight point definitions and alarm settings. With this information and an SNMP manager, you can monitor point values, command point values, and acknowledge alarms.

⚠️ The Integrated Systems department does not currently support an SNMP manager. Technical assistance, however, may be available on a case-by-case basis. For more information, contact the Integrated Systems department.

System Requirements

The system must include a computer with the following minimum requirements:

- Pentium Pro computer with 200 MHz processor
- 64 MB RAM
- 30 MB free hard drive space
- Microsoft Windows 2000 with Service Pack 1
- Microsoft Access
- Insight with the OPCServer Option installed and configured
Chapter 2 – Installing and Configuring the OPC/SNMP Agent

Chapter 2 contains the following topics:

• Before You Install the OPC/SNMP Agent
• Getting IP Addresses
• Setting Up SNMP Services
• Installing the OPC/SNMP Agent
• Requesting a License
• Setting Up the SNMP Database
• Setting Up the OPC Engineering Tool
• Setting Up the SNMP Engineering Tool

Before You Install the OPC/SNMP Agent

Before you install the OPC/SNMP Agent, install and configure Insight with the OPCServer Option. For details, see the Insight OPCServer documentation. Also, verify that Microsoft Access is installed on the Insight workstation.

Getting IP Addresses

Throughout the configuration process, you need to enter the IP Addresses for the Insight with OPCServer workstation and the computers that will access Insight via SNMP. After you get the addresses, keep them readily available.

To get the IP Addresses, do the following steps:

1. Click Start, Programs, Accessories, and Command Prompt to open the DOS prompt.
2. Type ipconfig, and then press ENTER.
   The IP Address for that computer is displayed.
Setting Up SNMP Services

To set up the SNMP services on the Insight workstation, do the following steps:

1. Click Start, Settings, Control Panel, and Add/Remove Programs.
2. In the Add/Remove Programs window, click Add/Remove Windows Components.
   The Windows Components Wizard is displayed.
3. In the Components box, select Management and Monitoring Tools, and then click Details.
   If any other protocols are listed and they are not needed, clear their check boxes.
5. Click OK to close the Management and Monitoring Tools dialog box.
6. In the Windows Components Wizard, click Next.
7. Insert the Windows 2000 CD and click OK, or just click OK to browse for the setup files.
8. When the Wizard is done installing the files, click Finish.
10. In the Services window, verify that the SNMP Service is set for the Automatic startup type.
11. Right-click SNMP Service, and then click Properties.
    The SNMP Service Properties dialog box is displayed.
12. Click the Traps tab, and then do the following to set criteria for outgoing messages:
   a. In the Community name box, type a system community name (such as public) that will use SNMP services to access Insight, and then click Add to list.
   b. Click Add.
13. In the SNMP Service Configuration dialog box, do the following:
   a. Type the IP Address of a computer that will receive Insight information via SNMP. The computer must belong the community identified in the previous step. For information on finding the IP Address, see Getting IP Addresses on page 9.
   b. Click Add.
   c. Repeat Steps 13a and 13b to identify other computers in that community.
14. If needed, repeat Steps 12 and 13 to identify computers in other communities.
15. If you want to set security on messages sent to the Insight workstation, then click the Security tab, and set access options. The default security is READ CREATE access for all SNMP hosts within the communities identified in Step 12.
16. Click OK to close the SNMP Service Properties dialog box.
17. Right-click SNMP Trap Service, and then click Properties.
18. In the SNMP Trap Service Properties dialog box, select Automatic from the Startup type list, and then click OK.
19. Close the Services window.
Installing the OPC/SNMP Agent

The OPC/SNMP Agent must be installed on the Insight workstation with the OPCServer. It is recommended that you create desktop shortcuts for the engineering tools to make them easy to start.

To install the OPC/SNMP Agent, do the following steps:

1. Log on to the Insight workstation using a user account with Administrator privileges.
2. Unzip ZIPCD.zip to the root directory. The OPC/SNMP Agent folders and files are added to the workstation.
3. In the Install folder, run SETUP.EXE.
4. In the SNMP-OPC Gateway installation wizard, do the following:
   a. In the Welcome dialog box, click Next.
   b. In the Software License Agreement dialog box, read the license agreement, and then click Yes.
   c. In the Information dialog box, click Next.
   d. In the Choose Destination Location dialog box, click Browse to select a different location.
   e. In the Setup Complete dialog box, click Finish to restart the workstation and complete the installation.
5. Create desktop shortcuts for:
   - SG_OPC_ENG_TOOL.exe (OPC Engineering Tool)
   - SNMPEngTool.exe (SNMP Engineering Tool)

Requesting a License

To request a license for the OPC/SNMP Agent, do the following steps:

2. In the SNMP_V2_Generation Utility dialog box, click ...
3. In the Save As dialog box, select a location for saving the file, enter a file name, and then click Save.
4. Click OK on the message box that confirms successful file creation.
5. Click OK to close the SNMP_V2_Generation Utility dialog box.
6. Email the generated file to Customsolutions1@sbt.siemens.com. A License Key file will be emailed to you.
7. Save the License Key file in the OPC/SNMP Agent folder.
Chapter 2 – Installing and Configuring the OPC/SNMP Agent

Setting Up the SNMP Database

An SNMP database must be created to link Insight OPCServer and MIB information.

To set up the SNMP database, do the following steps:

1. Click Start, Settings, Control Panel, Administrative Tools, and Data Sources (ODBC).
   The ODBC Data Source Administrator dialog box is displayed.
2. Click the System DSN tab, and then click Add.
3. In the Create New Data Source dialog box, select Microsoft Access Driver, and then click Finish.
4. In the ODBC Microsoft Access Setup dialog box, do the following:
   a. In the Data Source Name box, type a name for the SNMP database.
   b. Click Create.
5. In the New Database dialog box, do the following:
   a. In the Database Name box, type the name used in Step 4a.
   b. Select a location for storing the database.
   c. Click OK.
6. Click OK on the confirmation message box.
7. Click OK to close the ODBC Microsoft Access Setup dialog box.
8. Click OK to close the ODBC Data Source Administrator dialog box.
9. Close the Control Panel window if it is open.

Setting up the OPC Engineering Tool

The OPC Engineering Tool is used to select the OPCServer information that you want to monitor via SNMP. To set up the OPC Engineering Tool, you do the following:

- Verify that the Insight OPCServer Database is available
- Configure the OPC Engineering Tool

Verifying Communication with the Insight OPCServer Database

To verify that the OPC Engineering Tool can communicate with the OPCServer, do the following steps:

1. Run ISVcDataAccess (ISVcDataAccess.exe).
   ISVcDataAccess is installed with the OPCServer option for Insight and stored in the Insight/OPCServer directory.
   The ISVcDataAccess window is displayed.
2. On the OPC menu, click Connect.
3. In the Connect to OPC Server dialog box, select Insight OPCServerDA.1, and then click OK.
4. In the ISVcDataAccess window, verify that the message Successful to OPC server connected is displayed in the bottom pane.
5. In the top-left pane, right-click **Insight OPCServerDA.1**, and then click **Add Group**.

6. In the Group Definition dialog box, just click **OK**.
   
   A group, with the default name of Group1, is added and is displayed in the top-left pane.

7. Right-click the new group (Group1), and then click **Add Item**.

8. In the Add Item dialog box, do the following:
   
   a. Click **Find now**.
      
      The points in the Insight OPCServer database are listed. If no points appear, check the DCOM settings.
   
   b. Select all the points that you want to access via SNMP, and then click **OK**.
      
      If point information is displayed in the ISVcDataAccess window, then connection to the Insight OPCServer is successful. If no point information is displayed, then see troubleshooting information for the Insight OPCServer and check the COM/DCOM settings.

9. Close the ISVcDataAccess window.
   
   🕵️‍♂️ It is unnecessary to save the information; however, it may be useful if troubleshooting is needed.

**Configuring the OPC Engineering Tool**

To configure the OPC Engineering Tool, do the following steps:

1. Start the OPC Engineering Tool (**SG_OPC_ENG_Tool.exe**).
   
   The SG_OPC_ENG_Tool window is displayed.

2. On the **File** menu, click **New**.

3. In the New Database Settings dialog box, do the following:
   
   c. In the **DSN** box, type the name of the SNMP database.
   
   d. Leave the **User** and **Password** boxes blank.
   
   e. Click **OK**.

4. On the **Add** menu, click **Add Vendor**.

5. In the Add Vendor dialog box, do the following:
   
   a. In the **Vendor Name** box, type a name relating to the OPCServer database.
      
      🕵️‍♂️ Record the Vendor ID number and keep it handy. You will need this number for configuring the SNMP Engineering Tool
   
   b. Click **OK**.
      
      The name is displayed in the top-left pane of the SG_OPC_ENG_Tool window.

6. Click the vendor name that you just added.

7. On the **Connections** menu, click **Connect To OPCServer**.

8. Click **No** on the message box that asks whether to use local registry settings.

9. On the Set OPC Server dialog box, select **Insight OPCServerDA.1**, and then click **OK**.

10. On the **Connections** menu, click **Set OPC Server**.

12. In the Add Group dialog box, do the following:
   a. In the Group Name box, type a name for the group.
   b. In the Update Rate box, type a number of milliseconds. It is recommended to use 100.
   c. In the Percent Deadband box, leave 0.
   d. Select the Set Active check box.
   e. Click OK.

   You cannot modify a vendor or group once it is created. To change the information, you must delete the information, and then add the correct information.

13. In the top-left pane of the SG_OPC_ENG_Tool window, do the following:
   a. Click the group that you just added.
   b. On the Add menu, click Add OPCTag.

14. In the Add Item dialog box, do the following:
   a. Select the Active check box.
   b. Select an OPC tag from the Available OPC Tags from Current OPC Server list. The tag description is displayed in the OPC Tag box.
   c. Skip the OPC Tag Type box. This information will be automatically updated by OPCServer.
   d. If you want to change the access to OPC tag information, select a different access type in the OPC Access Type list.
   e. Click OK.

   A message stating that the item data type was changed by the server confirms communication.

15. Repeat Steps 13 and 14 to add more OPC tags to the selected group.

16. If you want to add more groups, click the vendor name, and then repeat Steps 11 through 15.

17. Close the SG_OPC_ENG_TOOL window to save the configuration settings.

Accessing and Viewing OPC Items

Using the OPC Engineering Tool, you can view Insight point information, confirm that point values can be monitored and commanded, and provide the SNMP Engineering Tool access to the OPC items.

To view and access OPC items, do the following:
1. Start the OPC Engineering Tool (SG_OPC_ENG_TOOL.exe).
2. On the File menu, click Open from Settings.
3. On the Connections menu, click Connect to OPCServer.
4. Click Yes to use settings from the local registry.
Setting Up the SNMP Engineering Tool

The SNMP Engineering Tool is used to define the information accessed via SNMP. To set up the SNMP Engineering Tool, you do the following:

- Enter general settings for the SNMP Engineering Tool
- Add MIB references

Entering General Settings for the SNMP Engineering Tool

To enter general settings, do the following steps:

1. Start the SNMP Engineering Tool (SNMPEngTool.exe).
   The SNMPEngTool window is displayed.
2. On the File menu, click New.
3. In the Open SNMP Database dialog box, do the following:
   a. In the DSN box, type the name of the SNMP database.
   b. Leave the User and Password boxes blank.
   c. Click OK.
   The Edit Settings dialog box is displayed.
5. In the File Settings tab, do the following:
   a. In the Log Files Location box, type the location and name of the SNMP Agent folder, or click ... to browse and enter the information.
   b. In the License File box, type the location and name of the License Key file, or click ... to browse and enter the information.
   c. In the SNMP Agent DLL box, type the location and name of the mfcsnmpdll.dll file, or click ... to browse and enter the information.
   d. Click OK.
6. Click the Other Settings tab, and then do the following:
   a. In the Maximum Number to Request from OPC box, type the number of points that you want to access with SNMP.
   b. In the Vendor ID for SNMP Module box, type the Vendor ID number that was assigned via the OPC Engineering Tool (Step 5a in the Configuring the OPC Engineering Tool procedure).
   c. Click OK.
7. Leave the SNMPEngTool window open for the next procedure, Adding MIB References.
Adding MIB References

In the SNMP Engineering Tool, you create MIB references to link OPCServer point information to information in an MIB. You will need to refer to the MIB file throughout this procedure.

To add MIB references, do the following steps:

1. Open the MIB file in Microsoft WordPad or other text editor, and find the group information (see Figure 2).
2. In the top-left pane of the SNMPEngTool window, click the top node.
3. On the MIB menu, click **Add Branch**.
4. In the Add Group dialog box, do the following:
   a. In the **Group Name** box, type the name of a group defined in the MIB.
   b. In the **OID** box, type the group object identifier number.
   c. Click **OK**.

   The group is displayed in the SNMPEngTool window.

   ```
   sibt OBJECT IDENTIFIER ::= {enterprises 6361}
   bms OBJECT IDENTIFIER ::= (sibt 2)
   -- groups in BMS
   ```

   ![Figure 2. Example of MIB Group Information.](image)

   5. Repeat Steps 2 through 4 for each group defined in the MIB.
6. Find a variable in the MIB file, and then determine its group (see Group Name in Figure 3).

7. In the top-left pane of the SNMPEngTool window, click the group (branch), and then click Add Variable from the MIB menu.

8. In the New Mib Variable dialog box, do the following:
   a. In the OID box, type the variable’s object identification number.
   b. In the Point Type box, select the appropriate type.
   c. For the Valid Range, enter the minimum and maximum numbers, as shown in the MIB.
   d. In the Variable Name box, type the variable name.
   e. In the Description box, type some information that you want to include, such as value descriptions.
   f. In the Information Source area, ensure that OPC Client Point is selected, and then select the point that matches the variable from the Select Point list. The point name is the same as the variable name, but with _CV at the end.
   g. In the Default Value box, type an appropriate value.
   h. Click the Status type—either Mandatory or Writeable.
   i. Click OK.

The variable is added to the group.

9. Repeat Steps 6 through 8 to add the other variables listed in the MIB. Be sure to select the appropriate group (Step 7) for each variable.
10. On the **MIB** menu, click **Add Trap**.

11. In the Trap dialog box, do the following:

   a. In the **Trap Enterprise ID** box, type the trap enterprise identification number.

   Each trap is associated with a variable. A trap’s Enterprise ID is the same number as the associated variable’s OID.

   b. In the **Trap Name** box, type the trap name.

   c. From the **Monitoring Variable** list, select the name of the associated variable.

   The list shows the variable name with periods instead of underscores.

   ![Diagram of MIB Trap Information]

   ```
   -- TRAP ID
   Trap Enterprise ID
   -- 8
   vt_8
   ```

   ```
   OBJECT-TYPE
   SYNTAX  DisplayString
   ACCESS  read-only
   STATUS  mandatory
   DESCRIPTION
   "TrapID: 8, OBJ: chw, VAR: it_chw_ac_p3"
   ::= (chw 15)
   
   vt_8 TRAP-TYPE
   ENTERPRISE  sibt
   VARIABLES  { vt_8 }
   DESCRIPTION
   "TrapID: 8, OBJ: chw, VAR: "
   ::= 8
   ```

**Figure 4. Example of MIB Trap Information.**
12. In the MIB, find the information for the associated variable, and then identify the Send Trap When information.

```
-- a) System Name | User Name | Descriptor Type | TrapID# | Display OD | Suffix
--- ------------------- ------------------- ------------------- ------------- --------------- -------
-- b) IT.CHW_AC.P4 | IT.CHW_AC.P4 | PUMP 4 | L2SL |

change from 0-1 or 1-0>R 0(OFF) or 1 (ON) 8

-- c) ALARM = "Pump 4 is not responding" OFF="Pump 4 Normal" .1.8

it_chw_ac_p4 OBJECT-TYPE
SYNTAX INTEGER (0..1)
```

Figure 5. Example of Trap Information Provided with Variable Information.

13. In the Trap dialog box, click Set Trap Conditions.

14. In the Build Condition for Trap dialog box, enter the information to describe trap conditions, and then click OK.

For example, [FROM] = 0 OR = 1
[TO] = 1 OR = 0

15. In the Trap dialog box, click Set Included Variables.

16. In the Trap Includes dialog box, do the following:

   a. Click the name of the Monitoring Variable in the Available Variables box.
   b. Click Add.
   c. Click OK.

17. In the Trap dialog box, click OK.

The trap is listed in the SNMPEngTool window.

18. Repeat Steps 10 through 17 to add the other traps listed in the MIB.

19. Close the SNMPEngTool window to save the information.